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Preface 

This document is a formal contract deliverable with an approval code 1. It requires Government 
review and approval prior to acceptance and use. This document is under ECS contractor 
configuration control. Once this document is approved, Contractor approved changes are 
handled in accordance with Class I and Class II change control requirements described in the 
ECS Project Configuration Management Plan, and changes to this document shall be made by 
document change notice (DCN) or by complete revision. 

This document is under the control of the EDF/Science Development Configuration Control 
Board (CCB). 

Any questions should be addressed to: 

Data Management Office 
The ECS Project Office 
Raytheon Systems Company 
1616 McCormick Dr. 
Upper Marlboro, MD 20774-5301 



 

 iv 609-CD-610-003 

This page intentionally left blank. 



 

 v 609-CD-610-003 

Abstract 

This document describes the human-machine interface (HMI) characteristics of the tools 
(computer software configuration items) used by the ECS operations staff and external users of 
ECS both registered and non-registered. 

Keywords:  Computer Software Configuration Items (CSCIs), GUI, Interface, Operations, 
Release 6B, Screens, Software and Tools  
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1.  Introduction 

1.1 Identification 
The Release 6B Operations Tools Manual, Contract Data Requirements List (CDRL) item 116, 
whose requirements are specified in the revised Data Item Description (DID) 609/OP1, is a 
required deliverable under contract NAS5-60000.   

1.2 Purpose 
This document describes the human-machine interface (HMI) characteristics of the tools 
(configuration items) used by the ECS operations staff when performing the following:  

• Computer systems administration 

• System monitoring 

• Configuration management 

• Security and accountability 

• Science software integration and testing 

• Resource planning 

• Production planning and processing 

• Science data ingest, archive and distribution 

• User services 

• Common services 

This document provides background information that is the basis for the Release 6B Operations 
Procedures for the ECS Project (DID 611/OP3). The 609 document is intended to (1) familiarize 
the ECS operators with their tools, (2) be used as a reference for all ECS operational tasks, and 
(3) be used as an aid during training of ECS operations staff.  

1.3 Scope 
This document applies to Release 6B, and not to any subsequent releases of the ECS. This 
document is limited to (1) a detailed description of customized operator tools, (2) a brief 
description of Commercial Off-the-Shelf (COTS) software used by operations and references to 
the applicable vendor manuals, and (3) a detailed description of customized COTS software. 
This document points to DID 611 for all operational procedures or to individual COTS manuals 
for detailed COTS instructions. Operators, maintainers, and external users of the ECS system 
intend it for use during the period in which Release 6B is operational. 



 

 1-2  609-CD-610-003 

1.4 Status and Schedule 
This submittal of DID 609/OP1 meets the milestone specified in the Contract Data Requirements 
List (CDRL) of NASA contract NAS5-60000. 

This document reflects the February 14, 1996 Technical Baseline (210-TP-001-006) submitted 
via contract correspondence No. ECS 194-00343. 

1.5 Organization 
This document is organized to describe the tools used by ECS operations staff and external users 
during Release 6B. 

Section 1.0 provides information regarding the identification, scope, purpose, status, and 
organization of this document. 

Section 2.0 provides a listing of related documents, which were used as source information for 
this document. The section also identifies the documentation provided for each Release 6B 
software component. 

Section 3.0 provides a brief overview of the Release 6B ECS. 

Section 4.0 provides a detailed description of Release 6B operations tools. It is organized by 
operation function and provides the following types of information: tools overview, required 
operating environment, CSCI function, operator commands, system messages, reports, and 
outputs.  

Appendix A provides a description of Release 6B system status and error messages, including 
probable causes, impacts, and proposed actions. 

The Abbreviations and Acronyms section contains an alphabetical list of the abbreviations and 
acronyms used in Release 6B. 

The Glossary section contains terms used in this document. 
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2.  Related Documentation 

2.1 Parent Documents 
The parent document is the document from which the scope and content of this Release 6B 
Operations Tools Manual has been derived.  

423-41-02 Goddard Space Flight Center, Functional and Performance 
Requirements Specification for the Earth Observing System Data and 
Information System (EOSDIS) Core System (ECS) 

423-41-03 EOSDIS Core System Contract Data Requirements Document 

2.2  Applicable Documents 
The following documents, referenced within this Release 6B Operations Tools Manual, are 
directly applicable or contain policies or other directive matters binding upon the content of this 
volume. 

102-CD-002 Maintenance and Operations Configuration Management Plan for the 
ECS Project 

205-CD-002 Science User's Guide and Operations Procedure Handbook, Volume 4: 
Software Developer's Guide to Preparation, Delivery, Integration and 
Test with ECS 

205-CD-004 Science User's Guide and Operations Procedures Handbook (Release 
B.0) for the ECS Project 

194-207-SE1 System Design Specification for the ECS Project 

304-CD-003 Communications and System Management Segment (CSMS) 
Requirements Specification for the ECS Project 

305/DV2 Segment/Design Specification for the ECS Project  

307-CD-002 Science Data Processing Segment Release and Development Plan for 
the ECS Project 

311-CD-600 Release 6B Data Management Database Design and Schema 
Specifications for the ECS Project 

311-CD-601 Release 6B INGEST Subsystem Database Design and Schema 
Specifications for the ECS Project 

311-CD-602 Release 6B Interoperability Subsystem (IOS) Database Design and 
Schema Specifications for the ECS Project 
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311-CD-603 Release 6B Planning and Data Processing Subsystem Database Design 
and Database Schema Specifications for the ECS Project  

311-CD-604 Release 6B Science Data Server Database Design and Schema 
Specifications for the ECS Project 

311-CD-605 Release 6B Storage Management Database Design and Schema 
Specifications for the ECS Project 

311-CD-606 Release 6B Subscription Server Database Design and Schema 
Specifications for the ECS Project 

601-CD-001 Maintenance and Operations Management Plan for the ECS Project 

604-CD-002 ECS Operations Concept for the ECS Project: Part 2B - ECS Release 
B 

605-CD-002 Release-B SDPS/CSMS Operations Scenarios for the ECS Project 

609-CD-001 Interim Release One (Ir1) Maintenance and Operator's Procedures for 
the ECS Project 

611-CD-600 Release 6B Mission Operation Procedures for the ECS Project 

613-CD-003 Release B COTS Maintenance Plan for the ECS Project 

625-CD-601 ECS Project Training Material Volume 1: Course Outline 

625-CD-602 ECS Project Training Material Volume 2: Introduction and System 
Overview 

625-CD-603 ECS Project Training Material Volume 3: Problem Management 

625-CD-604 ECS Project Training Material Volume 4: System Administration 

625-CD-605 ECS Training Material Volume 5: Network Administration 

625-CD-606 ECS Project Training Material Volume 6: Production Planning and 
Processing 

625-CD-607 ECS Project Training Material Volume 7: Resource Planning 

625-CD-608 ECS Project Training Material Volume 8: Ingest 

625-CD-009 ECS Project Training Material Volume 9: Data Distribution 

625-CD-010 ECS Project Training Material Volume 10: Archive Processing 

625-CD-011 ECS Project Training Material Volume 11: Database Administration 

625-CD-612 ECS Project Training Material Volume 12: Configuration 
Management 

625-CD-613 ECS Project Training Material Volume 13: User Services 
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625-CD-616 ECS Project Training Material Volume 16: Science Software 
Integration and Test 

625-CD-617 ECS Training Material Volume 17: System Troubleshooting 

420-TP-007 Planning Workbench Detailed Design for the ECS Project 

910-TDA-022 Custom Code Configuration Parameters - Rev06, May 2002 

IMSV0-OP-GD-001 GSFC, EOS Data Gateway; User Manual for EOS Data Gateway 

IMSV0-PD-SD-002 EOSDIS Information Management System EOS Data Gateway 
Messages and Development Data Dictionary for V0 and ASTER/ECS 
Message Passing Protocol Specification 

2.3 Information Documents 
The following documents are referenced herein, and amplify or clarify the information presented 
in this document. These documents are not binding on the content of the Release 6B Operations 
Tools Manual. 

Action Request System 2.0, Troubleshooting and Error Messages Guide (1995), Remedy 
Corporation, Mountain View, CA 

Action Request System 2.0, User’s Guide for OSF/Motif (1995), Remedy Corporation, Mountain 
View, CA 

Accell Publication Package, Unify Corporation, Sacramento, CA 

Accell Release Notes, Unify Corporation, Sacramento, CA 

AIX Version 4.1 iFOR/LS System Management Guide First Edition (1994), Gradient Technology 
Inc, 11400 Burnet Rd., Austin TX 78758-3493 

AIX Version 4.1 iFOR/LS Tips and Techniques First Edition (1994), Gradient Technology Inc, 
11400 Burnet Rd., Austin TX 78758-3493 

AMASS Overview Version 4.9(1997), EMASS Inc., 10949 East Peakview Ave., Englewood, CO 
80111  

AutoSys User Manual, Version 3.5, August 1995, AutoSystems Development Lab, PLATINUM 
Technology, Inc., Boulder, CO 

AutoXpert User Guide, Unix BETA Version 1.0, July 1995, AutoSystems Development Lab, 
PLATINUM Technology, Inc., Boulder, CO 

C Language Reference Manual (1995), Silicon Graphics, Inc., Mountain View, CA 
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ClearCase Administrator’s Manual, Unix Edition Release 2.0 and later (1995), 4000-013-B, 
Atria Software Inc., Natick, MA 

ClearCase Quick Reference Manual, Unix Edition Release 2.0 and later (1995), 4000-013-B, 
Atria Software Inc., Natick, MA 

ClearCase User’s Manual, Unix Edition Release 2.0.2 and later (1995), 4000-011-B, Atria 
Software Inc., Natick, MA 

Data Production Sofware and Science Computing Facility (SCF) Standards and Guidelines, Rev 
A, October 1996, 423-16-01, GSFC, Greenbelt, MD 

DCE Cell Manager 1.6.2 Overview and User’s Guide (1997), Chisholm Technologies Inc, 6805 
Capital of Texas Hwy, Austin TX 78731 

Displaying Information and Generating Reports (iFOR/LS) (1994), Gradient Technology Inc, 
11400 Burnet Rd., Austin TX 78758-3493 

Errors and Corrective Action (AMASS) Version 4.9 (1997), EMASS Inc, 10949 East Peakview 
Ave., Englewood, CO 80111  

Enterprise SQL Server Manager User’s Guide, Release 10.0.2 (1995), Sybase, Inc. Emeryville, 
CA 

Expert Analyzer Output File Format (1995), Network General Corporation, Menlo Park, CA 

Expert Sniffer Network Analyzer Operations (1995), Network General Corporation, Menlo Park, 
CA 

FDDI Overview and Guide to Troubleshooting (1995), Network General Corporation, Menlo 
Park, CA 

Fortran 77, Language Reference Manual (1991), Silicon Graphics, Inc., Mountain View, CA 

IDL Reference Guide, Interactive Data Language (1991), Volumes 1 and 2, Version 4.0, 
Research Systems, Inc., Boulder CO 
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3.  Release 6B Overview 

3.1 Release 6B Objectives 

3.1.1 Release 6B Capabilities 
The Earth Observing System (EOS) Data and Information System (EOSDIS) Core System (ECS) 
capabilities are developed in terms of formal releases. Release 6B, which is controlled by 
Configuration Management, provides capabilities to support the ingest and archive of raw data 
obtained from the EOS AM 1 mission spacecraft, morning equator crossing spacecraft series 
(Terra (AM-1)), EOS PM 1 mission spacecraft, afternoon equator crossing spacecraft series 
(Aqua (PM-1)) and the Land Remote-Sensing Satellite (Landsat 7). Other capabilities provided 
by Release 6B include processing the data obtained, distributing raw or processed data as 
requested, quality assurance of processed data, supporting communication networks, and systems 
monitoring via interfaces with the ECS operations staff. 

Release 6B unique capabilities include: 

• Data Pool Maintenance – A GUI providing an operator interface to monitor the current status 
of data pool inserts and to maintain specific data pool parameters; manages ECS and non-
ECS data collections. 

• Batch Insertion – A utility used by operators to insert granules residing in or outside of the 
ECS archive into the data pool. 

• Data Pool Cleanup – A utility used by operators to remove expired granules and their 
associated metadata and browse files from data pool disks and corresponding data pool 
database inventory. 

• Production Request Editor Generator – A command line interface that allows the user to 
create and activate a number of Routine Production Requests using information contained in 
an input file. 

• Order Manager – A command line utility use by the operations staff to submit order requests 
into the Order Manager System (OMS) database directly without knowing whether the Order 
Manager Server is up or down. 

• Spatial Subscription Server – A GUI used by operators to place a standing order 
(subscription) on an ECS event. 

• Bulk Metadata Generation Tool – A utility used by operators to make available the ftp URLs 
in the data pool to the ECS Clearing House (ECHO). 

• DTF Ingest – Provides the capability to ingest data from a DTF tape. 
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• Ingest ICESAT – Provides the capability to ingest ICESAT data via the INGEST SIPS 
interface. 

• SBSRV FtpPull Acquires – Allows subscriptions to be submitted that specify an FTP Pull 
Acquire as an action. 

• V0GW Access to Non-Science Collections – Enables searches to be conducted against non-
science collections and against granules without spatial and/or temporal metadata. 

• DDIST Data/Staging Logging – Provides Data Access and Staging Activity logs that record 
the activities associated with archive processing. 

• Attached DPRs/JDT ODForms – Provides the capability to construct a standing Product 
Processing Order associated with a Data Acquisition Request. 

• 4000 DPR – Incorporates performance enhancement to facilitate the processing of 4000 
DPRs/day. 

• Reprocessing – Capability incorporated to reprocess data products from any original or 
updated single data input or combination of inputs. 

• Science Data Server Performance Improvements include: 

• Batch Insert/Update – Optimizes SQL calls from the SDSRV to Sybase by grouping 
multiple statements into a single batch and sending them to Sybase together. 

• Malloc Reduction – Reduces the number of malloc operations on search, insert 
validation, and event notification to SBSRV. 

• Dirty Reads – Allows dirty reads when receiving a large number of insert and search 
requests at the same time. 

• Autoinspect – Stores metadata information in the SDSRV client so that some request 
from the client to the SDSRV can be eliminated. 

• Request Manager – Allows the STMGT client code to checkpoint requests directly to a 
database and permits servers to handle requests within a fixed number of threads. 

• V0 Gateway Enhancements – Capability to use EDG Client to perform searches on specified 
attributes.. 

Release 6B unique capabilities and modifications include: 

• Removal of DCE Cell Manager, replacing DCE library calls with socket-based library calls 
from custom developed code called CCS middleware.  The CCS middleware does not require 
a GUI. 

• Removal of the Stacker ID and Stacker Slot ID fields on the Media Ingest tab of the Data 
Ingest GUI. 

• Adding Landsat 7 IGS Browse. 
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• Adding Digital Linear Tape Distribution (DLT) as a Media Type within the Data 
Distribution Operator GUI. 

A more detailed overview of the Release 6B ECS can be found in the Release 6B 
Segment/Design Specifications for the ECS Project, 305-CD-610-003. 
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4.  Description of the ECS Operational Tools 

The human-machine interface (HMI) characteristics description of the software tools that the 
ECS operator uses to perform routine ECS operations is listed by the following major functional 
areas: 

4.1 Computer Systems Administration  

4.2 System Monitoring (Problem, Fault, and Performance Management)  

4.3 Configuration Management  

4.4 Security and Accountability  

4.5 Science Software Integration and Test 

4.6 ECS Data Ingest  

4.7 Resource Planning  

4.8 Production Planning  

4.9 Production Processing 

4.10 Science Data Archive and Distribution  

4.11 User Services Tools 

4.12 Common Services Tools 

When using this document, the reader should note the following: 

• The screens/GUIs presented in this section are samples and often do not reflect the actual 
window contents seen by the DAAC operator because they depend on hardware 
configuration, actual server names, directories, etc. 

• Basic Unix, Network and application configuration and utilities are not explicitly 
addressed in this document 

• Launching tools from the command line is avoided as much as possible to give operations 
management the ability to control (a) access to the Unix command line and shell; and (b) 
reduce the use of the xterm except for programs other than Motif programs 

• Release 6B directory structure is discussed in DID 612, which is the Programmer's 
Manual for each of the Release 6B DAACs and the SMC  

• This document references the ECS Baseline Information System web page, URL 
http://cmdm.east.hitc.com/, in several places for information on the Required Operating 
Environment.  This web page is currently being constructed for the desired information in 
the ECS Baseline.  Until it is put in place, the reader is referred to the DAAC library for 
hard copies of the desired COTS documents. 
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Note: 
The sample GUI screen images provided in the tool description in this document 
are best viewed on a computer terminal. The terminal provides the color and 
resolution needed to convey the screen design and usage. The terminal allows the 
user to view and enlarge the screen image to see the various fields on the screen 
images if they are unreadable.  A hard copy printout of a screen image can lose all 
of its color and a great deal of its resolution in going from a computer terminal to 
a printer to a Xerox machine. The transition from terminal to printer to Xerox 
machine can cause the quality to degenerate to the point the images are totally 
unreadable. 

 



 4.1-1 609-CD-610-003 

4.1 Computer Systems Administration 
This section describes the computer system administration tools used by DAAC operators: 
1. Legato’s Networker 
2. AMASS 
3. ISQL 
4. Sybase Replication Server 
5. ECSAssist 
6. ECS Registry GUI 
7. Whazzup GUI 
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4.1.1 Legato NetWorker 
The Legato Networker COTS Version 6.02 installed in ECS Release Solaris 8 has been verified 
to be “Y2K” compliant. 

Legato’s NetWorker is a set of three components -Administration, Backup, and Recovery - used 
by system administrators to back up the entire system, with the exception of DBMS files (see 
Section 4.1.5, “ISQL”, for details on backup of DBMS files). The basic configuration is to have 
a NetWorker Server with a backup device (i.e., Jukeboxes or 8mm tapes) networked to a number 
of clients that represent the subsystem hosts. 

NetWorker performs site-wide system backup. It provides a suite of integrated tools for backup 
and recovery, archive and retrieval, and hierarchical storage management. The product supports 
multi-platform networks, contains a motif-based GUI with on-line help, and supports concurrent 
device support for parallel backup and recovery using up to 16 storage devices. Authorized users 
can perform both scheduled and ad-hoc backups, recoveries and other data management services. 
NetWorker software consists of two components: a client portion, which runs on the systems to 
be backed up, and a server portion, which is the system to which the backup devices are 
connected. The client portion sends the data to be backed up to the server portion, which then 
writes the data out to disk. 

NetWorker is used to perform the operator functions listed in Table 4.1.1-1. 

Table 4.1.1-1.  Common ECS Operator Functions Performed with NetWorker 
Operating 
Function 

GUI Description When and Why to Use 

Manage, configure, 
and monitor 
NetWorker 

• NetWorker 
Administrator 
GUI 

Allows monitoring of server 
status, devices, sessions, 
messages, and pending 
displays 

To start NetWorker (NW) 
tasks and monitor server 
activity 

Monitor and 
schedule backup 

• NW Backup 
GUI 

• Group backup 
• Scheduled backup 
• Incremental backup 

To back up client files 

Recovering backed 
up files 

• NW Recover 
GUI 

Retrieves files that have 
been backed up 

To recover backed up client 
files 

4.1.1.1 Quick Start Using NetWorker 
This section presents an orientation of NetWorker. For more information, see the NetWorker 
User’s Guide, and the NetWorker Administrator’s Guide, Using NetWorker Windows and 
Menus. 

The documentation used is for version 5.5 of NetWorker. 
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4.1.1.1.1 Invoking NetWorker From the Command Line Interface 
The NetWorker Administrator tool is used to manage and configure the NetWorker environment. 
To execute NetWorker Administrator from the command line prompt use: 

 nwadmin <-s server_name> & 

The NetWorker Backup tool is used to backup files on client machines. To execute NetWorker 
Backup from the command line prompt use: 

 nwbackup <-s server_name> & 

The NetWorker Recover tool is used to recover files on client machines.  To execute NetWorker 
Recover from the command line prompt use: 

 nwrecover <-s server_name> &  

Note: The optional <-s server_name> is used only in NetWorker environments that have 
multiple NetWorker servers. 

4.1.1.2 NetWorker Main Screen 
Figure 4.1.1-1 shows the nwadmin screen. For more information on the NetWorker 
Administrator, see the NetWorker Administrator’s Guide.  
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Figure 4.1.1-1.  NetWorker Administrator’s Screen 

Figure 4.1.1-2 shows the nwbackup screen. For more information on NetWorker Backup, see the 
NetWorker User’s Guide. 
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Figure 4.1.1-2.  NetWorker Backup Screen 

Figure 4.1.1-3 shows the nwrecover screen. For more information on NetWorker Recover, see 
the NetWorker User’s Guide. 
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Figure 4.1.1-3.  NetWorker Recover Window 

4.1.1.3 Required Operating Environment 
For all COTS packages, appropriate information on operating environments, tunable parameters, 
environment variables, and a list of vendor documentation can be found in a CM controlled 
document for each product.  To find the documentation for Legato Networker, refer to the ECS 
Baseline Information System web page, URL http://cmdm.east.hitc.com/. 

4.1.1.4 Databases 
The $Installed_dir/nsr/index directory maintains a database of files that have been backed up and 
the availability of the backup such as tape number and whether it is online or on a volume of 
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tapes that has been migrated.  This information is in a proprietary format that can only be read 
using the nwrecover tool. 

4.1.1.5 Special Constraints 
None. 

4.1.1.6 Outputs 
NetWorker provides the capability to print and save contents of a window as a way to maintain 
records of NetWorker activities and configurations.  For more information, see Chapter 3, Using 
NetWorker Windows and Menus, NetWorker Administrator’s Guide. 

4.1.1.7 Event and Error Messages 
See Appendix A: Error Messages, NetWorker’s User’s Guide, and Appendix A: 
Troubleshooting, NetWorker Administrator’s Guide. 

4.1.1.8 Reports 

None.  
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4.1.2 AMASS 
AMASS is a file storage management system (FSMS) for the UNIX operating system. The 
purpose of AMASS in the EOSDIS Core System (ECS) is to provide an easy-to-use interface to  
large media archives. Media is defined as magnetic tape.  In terms of hardware, the FSMS host 
in the ECS architecture is a Silicon Graphics Inc. (SGI) Origin 300 and Origin 2000 servers. 
There are two main types of library used in ECStorageTek  (STK) 9310 Powderhorn using STK 
9840A, STK T9940A and STK T9940B tape drives. 

An STK 9360 Wolfcreek with STK tape drives is used in the VATC but is not deployed to 
operational sites. The operation of this silo is virtually the same as an STK Powderhorn. 

STK Powderhorns are used at GSFC, LaRC, NSIDC, EDC, and the PVC. Powderhorns consist 
of 6 major hardware parts: 

• The Automated Console System for Library Services (ACSLS) which is a Sun Ultra 
10 front end controller 

• The Automated Cartridge System (ACS) 

• The Cartridge Access Port (CAP) where tape media are inserted and ejected 

• The Library Management Unit (LMU) interface unit 

• The Library Control Unit (LCU) to control the robot Drive Racks, which hold up to 
18 9840, T9940A or T9940B drives per rack  

• The Library Storage Module (LSM), which includes the robot arms and the tape silo 
itself. The LSM includes a camera to display operation to the operator and the tape 
drives. Note that ACSLS is connected to the network via Ethernet 

The software components are more complicated. AMASS itself is the part that the user-of-the-
system actually uses. AMASS appears to the user as just another UNIX mount point and to and 
from which one copies, moves or deletes files using standard POSIX dd, mv or rm commands. 
An operator can view the contents of the archive, monitor the system, or setup new tapes for use 
through standard commands found in the Managing the AMASS File System  (Version 
5.3.1).AMASS is installed on an SGI platform. Control information is communicated from the 
SGI to ACSLS using TCP/IP protocols via Ethernet. Figure 4.1.2-1 shows the basic route that 
control information takes in sending a file to AMASS to a Powderhorn: 

1.  User/application initiates file transfer to an AMASS mount point. 

2.  AMASS receives the file over the network via ftp, dd or cp or locally via dd or cp to AMASS 
cache. 

3.  AMASS sends information over the network to ACSLS about what tape to load and which 
drive in which to load it. 

4.  ACSLS moves the arm to the media; the hand grips and retrieves the tape from the home slot 
and inserts it into the tape drive to complete the mount.  
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5.  The data is finally written to tape. 
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Figure 4.1.2-1.  Control Path 

The data path is much simpler. A SCSI controller on the SGI is directly connected to the SCSI 
port on the tape drive. Ideally, each drive gets its own controller. After the above process takes 
place, AMASS writes the file to the tape in a very simple block by block method. Note that the 
format of the tape is proprietary and NOT compatible with CPIO or TAR. 

AMASS uses both a command line and a GUI program called aawin to perform the system 
administration/operator functions listed in Table 4.1.2-1. 

Table 4.1.2-1.  Common ECS Operator Functions Performed with AMASS (1 of 3) 
Operating 
Function 

Command or GUI Description When and Why to Use 

Boot AMASS amass_boot Reboot AMASS Reboot AMASS 
Start AMASS amass_start Starts AMASS Initial startup. 
Activate or 
deactivate the 
AMASS file 
system 

amassstat 
aawin GUI  

Displays or toggles the 
status of AMASS 
(ACTIVE/INACTIVE). 

Used to inactivate the file-
system for maintenance 
and/or to reactivate it. 

Add a volume volnew 
aawin GUI 

Introduces a new volume to 
AMASS and assigns a 
volume number. 

To add storage space for 
data. 

Add space to 
a volume 
group 

volnew 
volgroup 
aawin GUI 

Adds additional volumes to 
an existing volume group. 

When more space is required 
in an existing volume group. 
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Table 4.1.2-1.  Common ECS Operator Functions Performed with AMASS (2 of 3) 
Operating 
Function 

Command or GUI Description When and Why to Use 

Create a 
space pool 

volnew 
aawin GUI 

One or more volumes 
assigned to a special 
volume group of the Space 
Pool (SP). 

To allow AMASS to 
automatically add space 
(volumes) to a volume group 
that has run out of space. 

Create a 
volume group 

volgroup 
setvolgrp 
aawin GUI 

Partitions the volumes in 
AMASS. 

To assign volumes for 
specific purposes within 
AMASS. 

Delete a 
volume 

volstat 
voldelete 
aawin GUI 

Removes a volume and its 
files from the archive. 

To delete a volume and any 
files it contains. 

Generate a 
report  

amassreport Generates standard or user 
defined report and/or raw 
output. 

To extract information about 
files and directories from the 
AMASS index. 

Back up the 
AMASS index 

amassbackup Performs full or partial back 
up of the AMASS index. 

Any time that the system 
needs to be backed up other 
than what AMASS’ automatic 
backup provides. 

Put a drive 
into service 

drivelist 
drivestat 
aawin GUI 

Displays the current status 
of the drives and to change 
the status. 

When an INACTIVE drive is 
ready to return to service. 

Recover dead 
space 

volspace 
volcomp 
volformat 
aawin GUI 

Compresses a selected 
volume. 

To recover dead space on 
volumes. 

Reinitialize the 
AMASS index 

Refer to the vendor 
documentation for the 
command and 
procedure 

Clears out the existing index 
and reinitializes it to an 
empty index. 

Only when AMASS is not 
running. 

Reintroduce 
an offline 
volume 

vollist 
volslot 
bulkinlet 
volloc 

Reintroduces an offline 
volume to a jukebox. 

If data from an offline volume 
needs to be referenced for 
read access. 

Remove a 
volume or 
volume group 
 

vollist, voloutlet, 
volloc 
aawin GUI  

Removes a volume or an 
entire volume group from 
the jukebox. 

To make room for new 
volumes or because data not 
being used needs to be 
retained. 

Remove 
space from a 
volume group 

vgroot #VG 
setvolgrp /path #VG 
volgroup 

Removes space from one 
volume group to add it to 
another. 

When space is needed in 
another volume group. 
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Table 4.1.2-1.  Common ECS Operator Functions Performed with AMASS (3 of 3) 
Operating 
Function 

Command or GUI Description When and Why to Use 

Replace a full 
backup 
volume 

voloutlet 1,  
bulkinlet 0, 
vollabel {to rename} 
tapelength 1 2 
volformat -b 256k 1 
amassbackup -fv 

Initializes a new backup 
volume and performs a full 
backup. 

When the backup volume is 
95% full. 

Restore the 
AMASS 
database 

amassrestore Restores the index either 
completely or to the point of 
the last full or partial 
backup. 

When the index is corrupt on 
the magnetic disk.  Do not 
use the amassrestore 
command when AMASS is 
running. 

Retrieve 
system usage 
by user 

amassreport Displays the number of files 
and directories owned by a 
user and the amount of 
space they take up. 

To get statistical information 
on the amount of space used 
by an individual(s). 

Retrieve 
system usage 
by volume 

adf Displays volume group, 
jukebox reference number, 
position of volume, amount 
of used space, number of 
directories and files on 
volume, amount of free and 
dead space. 

To get statistical information 
about the usage of a 
particular volume. 

Reuse a 
volume 

(volcomp, volstat, 
volclean, volformat 
aawin GUI 

Compresses and moves 
existing data to another 
volume, then reformats the 
volume. 

When a volume contains 
data no longer needed or 
contains mostly dead space. 

Take a drive 
out of service 

drivelist, drivestat 
aawin GUI 

Displays and changes the 
status of the drive. 

When a drive has excessive 
failures or for maintenance. 

Kill AMASS killdaemons Kills AMASS execution. When system downtime 
planned. 

 

4.1.2.1 Quick Start Using AMASS  
For more information about AMASS, refer to the Managing the AMASS File System and Using 
The AMASS GUI guides. 

The documentation of AMASS used as a basis and referenced in this section is for AMASS 
4.9.1.1 

4.1.2.1.1 Invoking AMASS From the Command Line Interface 
AMASS is normally started at boot and shutdown when the system is shutdown using scripts in 
the /etc/rc2.d and /etc/rc0.d directories that are linked to the actual scripts in /etc/init.d. AMASS 
can also be started and stopped from the command line. 
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To execute AMASS from the command line prompt use: 

/usr/amass/tools/amass_start 

To stop AMASS, type: 

t1drg01 100> /usr/amass/tools/killdaemons 

AMASS startup at boot can be enabled or disabled using the amass_atboot command. For more 
information on accessing AMASS via the command line, refer to Chapter 3, Command 
Reference, Managing the AMASS File System. 

The AMASSADMIN GUI can be started from the command line by typing 

/usr/amass/bin/aawin 

For more information on running the AMASS, refer to Using The AMASS GUI guide. 

For a description of AMASS commands and the functions they perform, see Chapter 2, 
Operational Tasks, and Chapter 3 , Commands of the Managing the AMASS File System.  

4.1.2.2 AMASS Main Screen 
AMASS allows the operator to perform a subset of the command line functions, as well as query 
online index and output results to a file for further processing. For more information on the 
AMASS, refer to Using the AMASS GUI guide. 

The window area of the AMASS Main Screen shown in Figure 4.1.2-2 is referred to as ‘The 
Workroom.’ 
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Figure 4.1.2-2.  AMASS Main Screen (AAWIN) 

AAWIN Pulldown Menu options: 
File 

Exit:  Exits AMASS. 
Clear Workroom:  Clears the Workroom of all icons. 

Tasks 
Modify a Volume Group: Change configuration of Volume Group. 
Modify a Volume: Change parameters associated with a Volume. 

Admin 
Scheduler:  Opens the Scheduler Status window. 
Sysperf:  Opens the sysperf window displaying the status of the AMASS activity. 

Preferences 
Show/Hide Detail Windows:  These windows give a brief description of the items the 

mouse pointer is touching.  
Help:  Opens the Help Window. 
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AMASS Utility Bar options  (the Utility Bar is a vertical toolbar on the right side of the Main 
Screen) 

Trash Can icon 
Volume Group icon displays the volume group icons in the Workroom as shown in Figure 

4.1.2-3. 
Volume icon displays volume icons in the Workroom. 
 

 

Figure 4.1.2-3.  AMASS Main Screen Showing Selected Volumes  
in the Workroom 

4.1.2.3 Required Operating Environment 
AMASS requires a UNIX environment.  AAWIN requires an X-window server. 
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For all COTS packages, appropriate information on operating environments, tunable parameters, 
environment variables, and a list of vendor documentation can be found in a CM controlled 
document for each product.  To find the installation and release notes for AMASS and ACLS, 
refer to the ECS Baseline Information System web page, URL, http://cmdm.east.hitc.com/. 

4.1.2.3.1 Interfaces and Data Types 
The commands and the AMASS GUI that operations staff use to interface with AMASS are 
described in the Managing the AMASS File System and Using The AMASS GUI. 

4.1.2.4 Databases  
The File Storage Management System provided by EMASS Company includes the RAIMA 
database product.  AMASS utilization of the database is transparent to the operator. 

4.1.2.5 Special Constraints 
None. 

4.1.2.6 Outputs 
Output from the AMASS consists of the data displayed on the GUI described in Section 4.1.2.2, 
database updates or additions to the database referenced in Section 4.1.2.4, error and event 
messages described in Section 4.1.2.7, and reports described in Section 4.1.2.8 which can 
produce file outputs in response to user actions or are printed. 

4.1.2.7 Event and Error Messages 
AMASS generates the following types of messages: 

• Informational (AMASS_I): Informational messages inform you about a process or 
situation. The status of AMASS is not changed when you receive an informational 
message. 

• Warning (AMASS_W): Warning messages inform you of situations that require 
attention but do not inhibit the functioning of AMASS. 

• Error (AMASS_E): Error messages require the immediate attention of the System 
Administrator to insure the proper functioning of AMASS. 

• System (AMASS_S): System messages indicate internal errors and should be reported to 
the EMASS Technical Assistance Center (ETAC). 

AMASS uses the standard syslogd function of the operating system for all of its warning, error 
and system messages. This facility allows the system administrator to control the output 
destination(s) of these messages. 

With the /etc/syslog.conf file, the operator can control the destination of each of the message 
types. The syslog.conf file is typically set up to log all levels of AMASS messages to 
var/adm/messages. The console is typically set up to see all AMASS levels generated by the 
kernel facility and the system and error level generated by the daemon facility. 
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For a description of AMASS event and error messages, refer to Errors and Corrective Action 
(AMASS) manual. 

4.1.2.8 Reports 
AMASS reports provide information of the AMASS holdings using the amassreport report 
generator.  Specific reports can be tailored  for specific information on the basis of selections by 
date, file, directory, errors, length, size, or IDs.  All reports have the column heading listed in 
Table 4.1.2-2. 

Table 4.1.2-2.  Amassreport Column Headings 
Heading Description  

Name Name of file. 
Parent Record ID of Parent. 
Last Accessed Last Accessed date on timestamp. 
Mode Permission IDs. 
Size File size in megabytes. 
File ID File Number. 
UID User ID 
GID Group ID 
Last Modified Date and time showing date the file was last modified. 
Vol File is located on this volume number. 

Table 4.1.2-3 below lists two types of AMASS reports using the amassreport command. 

Table 4.1.2-3.  Amassreport Report Types 
Output Description and Format 

Formatted report Prints a column header at the top of each page. 
Raw output Prints data without a column header. 

Can be used with other utilities to generate custom reports. 
 
The content of both types of tables is the same.  The raw output type is meant to be used to 
provide input for further processing to a more complete reporting system. 

For information on using amassreport see Chapter 3, Command Reference, Managing the 
AMASS File System. 
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4.1.2.8.1  Sample Report 
Figure 4.1.2-4 is an example of a formatted amassreport showing volume group 20. 

 

NAME                    FILEID  PARENT  UID  GID  LAST MODIFIED  LAST ACCESSED  MODE       VOL  
SIZE 
 
file_create             23         2    3137  20  Oct 21 10:06   Nov 06 18:17   drwxrwxr-x  20   
0 
testfiles1              171147     23   435   20  Oct 22 08:57   Nov 04 06:32   drwxr-xr-x  20   
0 
random_files            333451     23   435   20  Sep 11  1996   Nov 04 08:04   drwxr-xr-x  20   
0 
portioned_random_files  1751199    23   3137  20  Sep 25  1996   Nov 04 08:04   drwxr-xr-x  20   
0 
logs_tape               2975809    2    435   20  Oct 22  1996   Nov 03 23:01   drwxrwxr-x  20   
0 

 

Figure 4.1.2-4.  Amassreport Example Showing Volume Group 20 
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4.1.3  ISQL 
Interactive Structured Query Language (ISQL) is a stand-alone SQL command parser utility 
provided with the Sybase SQL Server and is available on all platforms that Sybase is available. 
ISQL is executed directly from the operating system level, and is used to interact with a SQL 
server and the databases on a SQL server. It allows for the interactive issuance and execution of 
Sybase Transact-SQL statements and sends the Transact-SQL commands to the SQL Server, 
formatting the results and printing them on the standard output. ISQL is used to perform the 
operator functions listed in Table 4.1.3-1. 

Table 4.1.3-1.  Common ECS Operator Functions Performed with ISQL (1 of 3) 
Operating 
Function 

Command/Script Description When and Why to Use 

Monitor 
database 
and user 
activity 

See Chapter 1 - Overview 
of System Administration 
in the System 
Administration Guide for 
ASE Server 

There are various 
database management 
activities performed in 
Sybase ASE Server to 
keep the databases 
running for day-to-day 
operations 

Database and user 
activity is monitored to 
manage and control 
various day-to-day 
operations of the DAAC 
and to prevent or resolve 
any unforeseen problems 

Provide and 
control users' 
database 
access 

• See Chapter 10 - 
Managing Adaptive 
Server Logins and 
Database Users in the 
System Administration 
Guide for ASE Server 

• See Chapter 11 - 
Managing User 
Permissions in the 
System Administration 
Guide for ASE Server 

• Create user accounts, 
set account default 
databases and other 
account configurable 
items 

• Grant proper 
permissions to user 
accounts 

• It may be necessary to 
provide access to 
individual users or 
groups of users on a 
temporary, permanent, 
or on-demand basis 

• Access to data at the 
DAAC should be 
controlled so it is not 
accidentally deleted, 
modified, or obtained 
without permission 
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Table 4.1.3-1.  Common ECS Operator Functions Performed with ISQL (2 of 3) 
Operating 
Function 

Command/Script Description When and Why to Use 

Grant roles 
and assign 
various 
privileges on 
database 
objects 

See Chapter 11 - 
Managing User 
Permissions -  Granting 
and Revoking roles in the 
System Administration 
Guide for ASE Server 
 

Roles and user accounts 
are necessary to provide 
access and security to 
databases under 
Sybase ASE Server 

• Proper database 
management roles such 
as SSO (System 
Security Officer), SA 
(System Administrator), 
OPER (Operator) are 
essential to the proper 
management of the 
databases at DAACs 

• Providing the proper 
level of privileges to 
each user of the 
databases prevents any 
accidental or 
unforeseen mishaps 
with the data (data 
integrity is also 
maintained) 

Monitor, 
control, and 
manage the 
use of disk 
space, 
memory and 
connections 

• See Chapter 3 – 
System Administration 
for Beginners (Allocating 
Physical Resources) in 
the System 
Administration Guide for 
ASE Server 

• Chapter 25 - Checking 
Database Consistency in 
the System 
Administration Guide for 
ASE Server 

• All databases running 
under Sybase ASE 
Server are physically 
stored on various 
devices and require 
various amounts of 
memory based on the 
usage of data 

• These resources have 
to be properly 
monitored 

• Resources for storage 
and manipulation of 
data are always at a 
premium 

• Proper management of 
these resources is 
essential in reducing 
errors, database 
crashes and unwanted 
downtime 

Backup and 
restore 
databases 

• See Chapter 26 - 
Developing a Backup 
and Recovery Plan in the 
System Administration 
Guide for ASE Server  

• Chapter 27 - Backing up 
and Restoring user 
databases, in the System 
Administration Guide for 
ASE Server  

• Chapter 28 - Backing up 
and Restoring the 
system databases in the 
System Administration 
Guide for ASE Server 

Backup of databases 
provides for quick 
recovery and 
maintenance of data 
integrity 

• Most Database 
Administrators perform 
a daily backup of all 
their databases and 
perform recovery 
operations when a 
database crashes and 
is unrecoverable by 
other recovery methods 

• Proper backup and 
recovery plans allow for 
full, quick recovery and 
zero loss of data 

• Regular backup of data, 
is essential in reducing 
downtime in case of a 
database crash 
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Table 4.1.3-1.  Common ECS Operator Functions Performed with ISQL (3 of 3) 
Operating 
Function 

Command/Script Description When and Why to Use 

Diagnose 
system 
problems 

• See Chapter 4 - 
Diagnosing System 
Problems in the System 
Administration Guide for 
ASE Server 

• Also see the SYBASE 
ASE  Server 
Troubleshooting and 
Error Messages Guide 

• Diagnosing problems 
with the operation of 
ASE Server is a 
regular part of 
database 
administration tasks 

• ISQL is used as a 
command line tool for 
interfacing with the 
ASE Server 

• Anytime the ASE server 
is not performing 
according to 
expectation or any 
database on SQL 
Server has crashed, the 
problem(s) must be 
diagnosed by checking 
current SQL Server 
status information 

• All problems must be 
properly resolved for 
successful operation of 
SQL Server 

Performance 
and Tuning 
Guide 

Performance and Tuning 
Guide Guide for ASE 
Server  

A continuous operations 
and administration 
activity can involve any 
of the above listed 
operating functions to 
make sure the ASE 
Server makes best use 
of its resources and to 
gain maximum 
performance from the 
ASE Server 

The ASE Server is fine-
tuned whenever storage 
or data requirements 
have changed, number of 
users have changed, new 
databases are added or 
existing databases are 
deleted, any SQL Server 
settings are modified, or 
any external environment 
changes have occurred 
which can impact the 
ASE  Server 

In addition, the DAAC user community can use ISQL to: 
• request data from various databases by issuing Transact-SQL statements 
• insert, update, or delete data from various databases by issuing Transact-SQL statements 
• change their passwords 

4.1.3.1  Quick Start Using ISQL 
This section presents an orientation of ISQL.  For more information on ISQL, refer to the SQL 
Server Utility Programs for UNIX.   

Other manuals that the operator can find useful are: 
• System Administration Guide for ASE Server ( ASE Server administration issues) 
• Configuration Guide ASE for Unix (operating-system specific system administration 

tasks) 
• Open Client DB-Library/C Reference Manual (man pages and code samples for the SQL 

Server interface library, Open Client DB-Library) 
• Installation Guide Adaptive Server Enterpise for Sun or Origin (there is a guide for each 

OS platform) Guide (installation procedures for SQL Server) 
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• ASE Server Reference Manual Vol. 1 and Vol. 2 ( commands and system procedures) 
• Troubleshooting and Error Messages Guide for ASE  

Further documentation support for Sybase’s ISQL can be found at the Sybase home page at:  
http://www.sybase.com/ 

4.1.3.1.1  Invoking ISQL From the Command Line Interface 
To execute ISQL from the command line prompt use: 
 isql 

For detailed instructions on how to invoke ISQL see Chapter 2 - Using ISQL in the A Utility 
guide for ASE Server. 

4.1.3.2  ISQL Main Screen 
There is no ISQL GUI.  The ISQL uses a command line interface for operator communications. 

4.1.3.3  Required Operating Environment 
The utility program ISQL is invoked directly from the UNIX operating system via the command 
line. 

For all COTS packages, appropriate information on operating environments, tunable parameters, 
environment variables, and a list of vendor documentation can be found in a CM controlled 
document for each product.  To find the documentation for ISQL, refer to the ECS Baseline 
Information System web page, URL http://cmdm.east.hitc.com/. 

4.1.3.3.1  Interfaces and Data Types 
ASE Server requires an interfaces file to map logical server names to physical network 
information about those servers. The interfaces file includes server name, network address, and 
the port number on which the server listens on for queries. For detailed information on the 
interfaces files, refer to the Open Client/Server Supplement for your operating system. 

4.1.3.4  Databases  
For more information on Sybase ASE Server databases, refer to the SYBASE System 
Administration Guide for ASE. 

4.1.3.5  Special Constraints 
None. 

4.1.3.6  Outputs 
Output from the ISQL consists of database updates or additions to the databases referenced in 
Section 4.1.3.4, and error and event messages referenced in Section 4.1.3.7. 

ISQL does not provide formatting options for the output, but the -n option eliminates ISQL 
prompts, while -e includes each command issued to ISQL in the output. Other tools can then be 
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used to reformat the output. For further information on formatting ISQL output, refer to the 
Utility  Guide for ASE.. 

4.1.3.7  Event and Error Messages 
Sybase SQL Server issues both status and error messages from the SQL Server and ISQL 
formats them to the designated output. For details on setting output options for ISQL the Utility 
Guide for ASE . 

For more information on error messages, their cause and corrective actions, refer to the 
Troubleshooting and Error Messages Guide. 

4.1.3.8  Reports 

None. 
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4.1.4 Sybase Replication Server 
The concept of a domain is useful when describing a replication system. Briefly, a domain is a 
set of replication servers and their associated components that communicate with each other. A 
domain can be one replication server that replicates data from a local primary database to 
another local replicate database (as in a warm standby application) or a domain can contain 
many replication servers distributed over a wide area network (WAN) as is the case for the MSS. 

Each domain requires one, and only one, ID server. An ID server is a replication server specified 
as such when it is installed. An ID Server assigns unique identifiers to domain components. The 
ID server must be the first replication server installed in a domain and must be accessible when 
any component is added to the domain. 

When a replication server is installed (including the ID Server), the following components are 
created: 

• A database called the replication server system database (RSSD) (the data server housing 
the RSSD must already exist) 

• A stable device (queue) 
• An interface (connection) to the RSSD data server 
• A RepAgent for the RSSD 

The RSSD contains system tables used by the replication server. In a multi-server domain that 
implements consolidated distributed primary fragments, the RSSDs must also be replicated. The 
RSSD contains information about each domain component, component login ids and passwords, 
application specific objects such as replication definitions, replicate transaction identifiers, 
routes and connections, and replicate transaction errors. 

The RSSD data model is documented in the manual Replication Server Reference Manual. 

As additional replication servers are added to a domain, the replication system administrator 
creates replication server interfaces (RSI), or routes, between the replication servers. Routes 
allow replicate transactions to “flow” from a primary replication server to a replicate replication 
server. 

Finally, application databases are added to a domain. For each database added to the domain the 
following components are created: 

• For primary databases, a log transfer manager (LTM), which transfers database 
transactions from the primary database to the replication server 

• For a replicate database, an interface from the replicate replication server to the replicate 
database 

The following components listed in Table 4.1.4-1 are used in a primary copy model that uses two 
replication servers.  This is for illustration purposes only. 
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Table 4.1.4-1.  Replication Server Components 
DAAC Component Description 

Primary Data Server  The primary data server is the Sybase ASE server that maintains the primary 
copy of data being replicated. 

Primary Database Contains the copy of data that can be updated by application programs. 
LTM The log transfer manager (LTM) is a Sybase Open Server application that 

transfers replicate database transactions to a primary replication server and 
moves the secondary truncation point in the primary database transaction log. 
The LTM connects to the primary data server as the primary database DBO and 
to the primary replication server as specified when the primary database is added 
to the domain. 

Primary Replication 
Server 

The primary replication server (PRS) is responsible for forwarding replicate 
database transactions to the replicate database. The PRS maintains connections 
to the replicate replication servers (route) and maintains a connection to its 
database, the RSSD.  

Primary RSSD Data 
Server 

The primary RSSD data server maintains the primary RSSD.  

RSSD RepAgent The RSSD RepAgent is a thread in the primary RSSD data server that transfers 
replicate RSSD database transactions to the PRS. The RSSD RepAgent 
connects to the PRS as specified when the PRS is added to the domain. 

Primary RSSD 
Database 

This database houses the information required by the replication servers to 
operate. 

PRS Stable Device The PRS stable Device contains a First In, First Out (FIFO) queue for each 
primary and replicate database. Transactions are transferred from a primary 
database queue to a replicate database queue after the LTM sends the 
transaction’s commit. Once a transaction is moved to the replicate database 
queue, the primary replication server sends the transaction to the replicate 
replication server. 

Replicate 
Replication Server 

The replicate replication server (RRS) is a replication server that receives 
replicate transactions from a primary replication server and applies the 
transaction to a replicate database. The RRS maintains a maintenance user 
connection for each replicate database. 

Replicate RSSD 
Data Server 

This server houses the RSSD for the RRS. 

Replicate RSSD This database contains information required for the RRS to apply replicate 
database transactions to a replicate database. 

RRS Stable Device The RRS stable device is a file system containing a FIFO queue for each 
replicate database. Replicate database transactions are pushed into the queue 
before being applied to the replicate database. 

Replicate Data 
Server 

This server houses the replicate database and is updated by the RRS. 

Replicate Database The database that contains the replicate data. 
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4.1.4.1 Quick Start using the Sybase Replication Server 
To start the Sybase replication servers from the command line, enter the following commands: 

 Source Sybase environment variables 

 ./Run_<replicationservername>_srvr & 

 ./Run_<replicationrsmname>_srvr & 

4.1.4.2 Sybase Replication Server Main Screen  
The database administrator can view what is happening with the Sybase Replication Servers by 
viewing the screen found in Figure 4.1.4-1. An administrator can click on any icon on the screen 
to find out the status of any replication server in the network. The status information shows up in 
the window below the screen. 

Replication Server Administration 
Administering the replication system is primarily the role of the Replication System 
Administrator (RSA). The Database Administrator (DBA) plays a subsidiary role by supporting 
some Replication Server administration tasks. At the DAACs, role distinctions may not be clear-
cut and some responsibilities can overlap. The following sections describe the Replication Server 
Administrator role and the tasks associated with Replication Server Administration. DBA tasks 
are not covered in this document. 

Replication System Administrator 
The Replication System Administrator installs, configures, and administers the replication 
system. Given the distributed nature of the MSS implementation, this role can be performed by 
different people at different locations. If this is the case, various tasks for administering 
Replication Server can require coordination between Replication System Administrators. 

The Replication System Administrator has user permissions, which provides that person with the 
capability to execute nearly all commands in the replication system. In managing the system, the 
Replication System Administrator may need to coordinate with DBAs for both local and remote 
databases. 

Replication System Administrators should be experienced Sybase DBAs and should have taken 
the Sybase training classes Replication System Administration and Replication Disaster 
Recovery Workshop. They should have also read and understood the manuals: Replication 
Server Administration Guide, Replication Server Configuration Guide for UNIX Platforms, 
Replication Server Reference Manual, and Replication Trouble Shooting Guide. 
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Replication Server Administrative Tasks 
The following tasks are required to maintain a replication system: 
 

Task Roles 
Installing Replication Server Replication System 

Administrator (RSA), Database 
Administrator (DBA) 

Adding or removing a Replication Server RSA 
Starting up and shutting down Replication Server RSA 
Configuring Replication Server RSA 
Maintaining Routes (Creating and modifying) RSA 
Managing the RSSD RSA, DBA 
Adding a primary and replicate database RSA, DBA 
Adding login names, database users, and administering appropriate 
permissions 

RSA, DBA 

Adding replicated tables or changing table schemas 
Creating and modifying replicated tables 
Creating and modifying replication definitions 
Creating and materializing subscriptions at replicate sites 

RSA, DBA 

Defining data server function-string classes and function strings RSA, DBA 
Applying database recovery procedures RSA, DBA 
Maintaining and monitoring database connections RSA 
Monitoring Replication Server RSA 
Processing rejected transactions RSA, DBA 
Quiesing Replication Server RSA, DBA 
Reconciling database inconsistencies RSA, DBA 
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Figure 4.1.4-1.  Sybase Central Topology GUI 

Replication Administration Software 
COTS and/or custom software (scripts) support some of the Replication Server administration 
tasks. The COTS consists of the Sybase products Replication Server Manager (RSM) and Sybase 
Central, a GUI based administration tool. 

RSM provides status information to and accepts administrative commands from Sybase Central 
and executes custom scripts in response to events in the replication domain. The GUI provides a 
graphical topology of the replication system domain with near real-time status on each 
component. Although the GUI can be used to perform many administration tasks, its use is 
procedurally limited to the replication server administrative tasks identified below. 
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Installation 
Scripts were developed for the following administration tasks in support of installing and 
configuring Replication Server and for installing replication server objects that are specific to the 
MSS application. 

• Creating Routes 
• Managing the RSSD 
• Adding login names, database users, and permissions 
• Creation of replication definitions, subscriptions, function strings and error classes 
• Subscription materialization 

Monitoring 
The Sybase Central/RSM products are used for the following tasks: 

• Configuring Replication Server 
• Modifying Routes 
• Maintaining and monitoring database connections 
• Monitoring Replication Server 

Recovery 
Scripts were developed to restore the RSSD or to bring application databases to a consistent 
state. 

RSSD Recovery: 
• Dumpdb 
• Dumptran 
• Logsegment threshold 
• Data segment threshold 

MSS Database Recover: 
• Last chance logsegment threshold modification to disable secondary truncation point  
• Rs_subcmp scripts for each subscription in the domain 

Sybase Central/RSM is used for the following recovery tasks: 
• Processing Rejected Transactions 
• Quiesing Replication Server 

Network and Security Requirements 
The Sybase interface files used by the Replication Servers at each DAAC are modified to locate 
all Sybase Replication and Data Server in the replication domain. Additionally, subscription 
materialization requires the same user id and password for the replicate replication server and the 
primary and replicate data servers. Replication server userid and password maintenance must be 
coordinated across sites. Replication server supports password encryption, and this feature is 
used. 
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4.1.4.3 Required Operating Environment 
The Sybase Replication Server can run on Sun hosts (Solaris 2.x OS) and Origin (Origin IRIX 
6.x) hosts.  The ECS configuration only uses Solaris 2.x OS. 

For all COTS packages, appropriate information on operating environments, tunable parameters, 
environment variables, and a list of vendor documentation can be found in a CM controlled 
environment.  Additional Information can be obtained by visiting the sybooks.sybase.com web 
site. 

4.1.4.4 Databases  
Replication creates its own database created on a specified ASE Server. 

4.1.4.5 Special Constraints 
None 

4.1.4.6 Outputs 
Output from Tivoli is displayed on the screen in the form of its GUIs or a log entry (discussed in 
Section 4.1.4.7). 

4.1.4.7 Event and Error Messages 
Scripts executed by the RSM have been developed to notify the RSA of the following events: 
 
Component Event 

Servers Active, Quiesed, Suspect, Hung, Shutdown, Dead, Unknown, and Invalid 
Routes Change in status 
Connection Change in status 
Partition State change, size threshold exceeded 
Queues Latency threshold exceeded, size threshold exceeded 
Database Latency threshold exceeded 

4.1.4.8 Reports 
None 
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4.1.5 ECS Assistant 
The ECS Assistant (ECSAssist) is a custom program that simplifies the process of installation, 
testing and management of ECS.  This utility is basically an installation tool having practical 
application in the operations environment.  The tool is for use in installing software and 
maintaining the information related to that software.  Only the Subsystem Manager function of 
ECSAssist should be used in the ECS operational environment. 

Table 4.1.5-1 summarizes the functions that ECSAssist provides. 

Table 4.1.5-1. Common Tasks Performed with ECSAssist  
Task Description When and Why to Use 

Subsystem 
Manager actions 

Selections on the Subsystem 
Manager’s screen, see section 
4.1.5.2.1. 

Installing software and performing 
maintenance on software parameters. 

Database Used to install, drop, patch, and 
update subsystem specific 
databases. 

When database updates or upgrades 
are implemented. See Section 
4.1.5.2.1.1. See Section 4.1.5.2.1.2 to 
provide parameters to start database 
scripts. 

Install Used to install ECS custom software 
into the selected mode. 

As necessary to install software.  See 
Section 4.1.5.2.1.3. 

Shutdown Servers Shutdown server(s) for a selected 
component, application or 
executable. 

When restart of a server is necessary or 
a server use has completed.  

Configuration Creates Configuration File (CFG) 
and Parameter Configuration (PCFG) 
files for selected components. 

When installing or updating software 
components.  See Section 4.1.5.2.1.4 
for configuration parameters entered by 
the user. See Section 4.1.5.2.1.5 to 
create CFG and PCFG files for selected 
components. 

Registry Data 
Patch 

Used to update the registry database As desired for registry database 
updates.  See Section 4.1.5.2.1.6. 

Stage Area 
Installation 

Used to capture the location of the 
delivered software staging area. 

As desired to identify a staging area. 
See Section 4.1.5.2.1.7. 

Start Servers Used to start servers within the 
selected component, application or 
executable. 

Each DAAC has unique start scripts 
that start one or all required servers.  
This task is generally used during test 
periods. 

ESDT Manager Supports configuring of ESDTs at the 
DAAC into a mode. 

As needed to configure new ESDTs at 
DAAC. See Section 4.1.5.2.2 
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4.1.5.1 Quick Start Using ECSAssist 
To execute ECSAssist from the command line prompt use the following procedure: 

>./EcCoAssist source_file location [ssh] 

where source_file location can be: 

/tools/common/ea – or –  

/ecs/formal/COMMON/scripts – or -  

any directory where ECSAssist resides. 

Type ssh, as an argument, if you want EASI to use Secure Shell to connect to hosts. 

The default is to use Remote Shell. 

>setenv DISPLAY <current_host>  

>setenv ECS_HOME /usr/ecs  

>setenv DEBUG 1  (Set only to capture any errors generated by ECSAssist) 

The /tools mount point must be mounted. 

File /tools/common/ea must exist in the path.  (This can be set in the .cshrc or .kshrc file) 

>EA      

…or, if this alias is not available, use the following: 

> /tools/common/ea/EcCoAssist /tools/common/ea [ssh] & 

A screen labeled "Thanks for choosing ECS Assistant" appears for 5 seconds. 

The following text is displayed: 

“debug is [ enabled | disabled ]” depending if DEBUG is set. 

EASI uses [ Secure Shell | Remote Shell ] to connect to hosts… 

4.1.5.2 ECSAssist Main Screen 
The ECSAssist main screen shown in Figure 4.1.5-1 identifies the user, host machine, ECS site 
and ClearCase view in effect.  From the main screen, the user may invoke ECSAssist functions 
as described in Table 4.1.5-2. 
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Figure 4.1.5-1.  ECSAssist Main Screen 

Table 4.1.5-2 summarizes the information and capabilities presented on the ECSAssist Main 
Screen. 

Table 4.1.5-2.  ECSAssist Options and Field Descriptions (1 of 2) 
Option/Field Action Description 

User: Display only User’s logon ID. 
Host: Display only Host on which executing. 
Site: Display only ECS site ID. 
View Display only Clearcase view in effect. 
Toolbar  menus 
File Click on File on the toolbar of the 

ECS Assistant screen. 
Pull down menu showing the following 
options. 

Clear Debug File In the File menu, click Clear Debug 
File. 

Clear contents of debug log file. 

Preferences In the File menu, click Preferences. Allows user to select preferences. 
Exit Click Exit Terminates ECSAssist execution. 

Help Click on Help on the ECS Assistant 
screen Toolbar. 

Pulls down menu showing “Contents”, 
“Read Me” and “About” selections.  
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Table 4.1.5-2. ECSAssist Options and Field Descriptions (2 of 2) 
Option/Field Action Description 

Function buttons: 
Subsystem 
Manager 

Perform software installation and 
maintenance functions. 

See Section 4.1.5.2.1. 

ESDT Manager Clicking this button invokes the 
Earth Science Data Type (ESDT) 
Manager 

 

E.A.S.I. Clicking this button invokes the 
ECSAssist Simple Installation 
(EASI) option. 

Allows one user to facilitate a complete 
(FULL) or custom installation of ECS 
software. 

Help Click on Help Brings up Help on use of ECSAssist. 
Exit Click on Exit Terminates ECSAssist execution. 

4.1.5.2.1 The ECSAssist Subsystem Manager  
Click on the Subsystem Manager button in the ECSAssist Main Screen.  Figure 4.1.5-2 below 
presents the ECSAssist Subsystem Manager screen. Note: The Interoperability Subsystem 
(IOS) has been removed from the baseline system for this version of Release 6B. 
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Figure 4.1.5-2.  Subsystem Manager Screen
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The Subsystem Manager toolbar and Common Tasks options are described in Table 4.1.5-3. 

Table 4.1.5-3.  ECSAssist Subsystem Manager Toolbar (1 of 2) 
Option/Field Action Description 

Toolbar options: 
File Click on File on the Subsystem 

Manager screen Toolbar. 
Pull down menu showing Save As and 
Close selections. 

ESDT Manager In the File menu, click ESDT 
Manager. 

Used to configure (copy) descriptor files 
and associated shared objects to the 
proper location. 

Clear Debug File In the File menu, click Clear 
Debug File. 

Allows user to clear current contents from 
debug file /[HOME_DIR]/.EA_DebugLog. 

ClearTask Output File In the File menu, click Clear 
Task output File. 

Allows users to clear the file containing 
installation specific results. 

Preferences In the file menu, click 
Preferences. 

Allows users to select preferences. 

Exit In the file menu, click Exit. Exits Subsystem Manager. 
Tools    

Clean Logs In the Tools menu, click Clean 
logs. 

Allows users to remove outdated log files.

System Messages In the Tools menu, click on 
“System Messages.” 

Displays system messages from 
/var/adm. 

Re-Read .sitemap file In the Tools menu, click on 
“Re-read .sitemap file.” 

If there is a change to the .sitemap file, 
this function re-reads to obtain the latest 
information. 

 Override .sitemap file (EDF 
Only) 

In the Tools menu. click 
“Override .sitemap file.” 

Only available to EDF sites.  Used for 
custom sitemap files. 

   
 Registry Data Patch In the Tools menu, click 

“Registry Data Patch.” 
Allows user to update registry database. 

Utilities   
DB Viewer In the Utilities menu, click “DB 

Viewer.” 
Requires Database login to view inserted 
granules. 

Extensions In the Utilities menu, click 
“Extensions.” 

Pulls down menu showing a list of 
subsystem specific executables used for 
supporting tasks. 

Help Click on Help on the 
Subsystem Manager Screen 
Toolbar. 

Displays latest information about 
ECSAssist. 
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Table 4.1.5-3.  ECSAssist Subsystem Manager Toolbar (2 of 2) 
Option/Field Action Description 

Common Tasks - Area of the screen below toolbar containing the 
following specialized task buttons. 

database Click on Database button Used to install, drop, patch, and update 
subsystem specific databases. 

install Click on Install button Used to install ECS custom software into the 
selected mode. 

Shutdown Servers Click on Shutdown 
Servers button 

When restart of server is necessary or server 
use has completed. 

Configuration Click on Configuration 
button 

Creates CFG and PCFG files for selected 
components. 

Stage Area Installation Click on Stage Area 
Installation button 

Used to capture the location of the staging area. 

Start Servers Click on Start Servers 
button 

Each DAAC has unique start scripts that start 
one or all required servers.  This task is 
generally used during test periods. 

View Task Output Used to view task log 
files. 

As desired to view log files. See section 
4.1.5.2.1.8. 

Frame 1 Display Only -- 
Mode Listbox Click Click to display a list of available modes. 
Subsystems Hierarchical 
Listing 

Double Click Double click to display associated components, 
applications and executables. 

Frame 2 Display Only -- 
Settings Display Only Lists user’s current selections. 
Installation Statistics Display Only List installation specific statistics. 
Legend Display Only When an install task has completed, a color of 

Yellow, Red or Green highlights the selected 
subsystem to denote the severity of the install 
as follows: 
  Green - Completed installation successfully 
  Yellow - Install warnings 
  Red  - Install errors 

4.1.5.2.1.1 ECSAssist Subsystem Manager’s “database” Screen 
The Database Configuration Screen is used to install, drop, patch, and update subsystem specific 
databases.  From the ECSAssist Subsystem Manager screen, click the database button to initiate 
the database process.  If there is more than one database parameter file (.dbparms) detected when 
the database button is pressed, ECSAssist asks which one to use with the File Selection popup 
window shown in Figure 4.1.5-3.  The file selection popup window, above the “Ok” and 
“Cancel” buttons, contains the name of the database parameter files detected. 
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Figure 4.1.5-3.  File Selection Popup Window 

Select one of the .dbparms files to use and then click on the Ok button.  The fields or options for 
this screen are described in Table 4.1.5-4. 

Table 4.1.5-4.  Database Parameter File Selection Option/Field Descriptions 
Option/Field Action Description 

File list Click on desired the 
parameter file. 

Contains list of .dbparms type files 
discovered.  Click on the one to use and 
then click the Ok button. 

Ok (button) Click this after selecting 
a .dbparms type file in 
the file list. 

Launches database script screen associated 
with the selected parameter file in the file 
list. 

Cancel (button) Click this after selecting 
a .dparms type file if you 
do not want to see a 
screen associated with 
the selected parameter 
file. 

Closes the file list and the screen goes 
away. 

On selection of a .dbparms file, ECSAssist brings up the Database Configuration Screen shown 
in Figure 4.1.5-4. 
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Figure 4.1.5-4.  Subsystem Manager “Database” Screen 

Table 4.1.5-5 describes the fields displayed on the "database" screen. 

Table 4.1.5-5.  ECSAssist Subsystem Manager’s “Database” Field Descriptions 
Option/Field Action Description 

Database Config Screen Display Only Window title. 
EcDsSrDbBuild Display Only Component passed from the Subsystem Manager 

screen. 
SQSSERVER Entry Configurable item for the displayed Component. 
GROUPNAME Entry Configurable item for the displayed Component. 

ENVIRONMENT Entry Configurable item for the displayed Component. 
OK Click Displays the database script screen. 
Cancel Click Aborts process. 

4.1.5.2.1.2 ECSAssist Subsystem Manager’s “database script parameters” Screen 
This screen is triggered from the ECSAssist Subsystem Manager’s “database” screen, Section 
4.1.5.2.1.1 above.  The screen is used to input the parameters to set up the database.  In the 
ECSAssist Subsystem Manager’s “Database Script Parameters” screen, shown in Figure 4.1.5-5, 
the user must enter all parameters to initiate the respective database script.  
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Figure 4.1.5-5.  Subsystem Manager “Database Script Parameters” Screen 

Table 4.1.5-6 describes the control and information fields on the "database script parameters" 
screen. 

Table 4.1.5-6.  ECSAssist Subsystem Manager’s “Database Script Parameters” 
Screen Field Descriptions 

Option/Field Action Description 
Database Script Parameters Display Only Window title 
EcDsSrDbBuild Display Only Title 

Mode Display Only Displays selected mode. 
DBO ID Entry Enter dbo id 

Password Entry Enter password 
SQL Server Name Entry Enter sql server name 
Database Name Entry Enter database name 

OK Click Initiates process 
Cancel Click Aborts process 

4.1.5.2.1.3 ECSAssist Subsystem Manager’s Install Screen 
This screen is used to install ECS custom software into the selected mode.  From the ECSAssist 
Subsystem Manager screen click the install button to initiate the installation process. 

Figure 4.1.5-6 presents the Install screen. 
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Figure 4.1.5-6.  Subsystem Manager Install Screen 

Table 4.1.5-7 describes the control and information fields on the install screen. 
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Table 4.1.5-7.  ECSAssist Subsystem Manager Install Option or Field Descriptions 
Option/Field Action Description 

Installation Type Display Only Heading. 
Development Click Creates symbolic links to ClearCase. 

Normal Click Copies binaries and libraries to selected mode. 
Staging Area Click Installs Mode from staging area. 

Source File Location Display Only Heading. 
Stage Click To obtain files from the nightly build. 

Non Stage Click Allows testing of changes before a merge to branch is 
performed. 

Use current site 
specific configuration 
values? 

Display Only Heading. 

Yes Click Use site-specific .cfgparms and .dbparms file. 
No Click Do not use site-specific .cfgparms and .dbparms file.  

Allow the user to make the selection of choice. 
Ok Click Executes installation process. 
Cancel Click Aborts Installation process. 

4.1.5.2.1.4 ECSAssist Subsystem Manager’s “Configuration File Selection” 
Screen 
The configuration file selection window shown in Figure 4.1.5-7 allows a user to select a 
.cfgparms file with configuration values that were entered by the user or should be used when 
starting servers. 

 

Figure 4.1.5-7. Configuration File Selection Window 
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Table 4.1.5-8 describes the control and information fields on the configuration selection window. 

Table 4.1.5-8.  Configuration File Selection Window Field Description 
Option/Field Action Description 

Listbox Click on entry in list Select file of choice; enables Ok button. 
Ok Click Launches configurable parameters screen. 

4.1.5.2.1.5 ECSAssist Subsystem Manager’s “Configuration” screen 
Clicking the “Configuration” button on the ECSAssist Subsystem Manager screen brings up the 
“mkcfg” window shown in Figure 4.1.5-8.  Through this screen, ECSAssist creates CFG and 
PCFG files for selected components.   

 

Figure 4.1.5-8.  Subsystem Manager “Configuration” Screen 

Table 4.1.5-9 describes the control and information fields on the "mkcfg" screen. 

Table 4.1.5-9.  ECSAssist Subsystem Manager “Configuration” Field Descriptions 
Option/Field Action Description 

EcDsHdfEosServer Click Allows the user to configure the HDF EOS Server. 
EcDsScienceDataServerClient Click Allows the user to configure the Science Data Server 

Client. 
EcDsScienceDataServer Click Allows the user to configure the Science Data Server. 
EcDsSdSrvGui Click Allows the user to configure the Science Data Server 

GUI. 
EcDsSdSrvGuiMkcfg Display Only --  
DSServerUR Enter User enters specific data to the DSServerUR. 
Ok Click Executes configuration process. 
Cancel Click Aborts configuration process. 
Print Click Prints configuration parameters. 
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4.1.5.2.1.6 ECSAssist Subsystem Manager’s “Registry Patch” Screen 
Clicking “Apply Registry Data Patch” under the Tools menu option is the registry patch screen, 
shown in Figure 4.1.5-9. This screen allows users to apply updates to the registry database.  

 

Figure 4.1.5-9.  Subsystem Manager “Registry Patch” Screen 

Table 4.1.5-10 describes the control and information fields on the "Registry Patch" screen. 

Table 4.1.5-10. ECSAssist Subsystem Manager’s Monitor Field Descriptions 
Option/Field Action Description 

Apply Registry Data Patch Display Only Window title. 
“Registry Data Server” Entry   Database Server (e.g., t1icg01_srvr). 
“Registry DBO Id” Entry Database Owner ID (e.g., css_role). 
“Registry Password” Entry Database Password. 
“Registry DB Name” Entry Database Name  (e.g., EcCsRegistry).  Press enter 

to fill available “Attribute Trees” into “Tree To Patch” 
Combo box. 

“Tree To Patch” Entry/Combo 
box 

Enter Attribute Tree name or click the arrow to 
select Attribute Tree of choice from list. 

“Patch File” Entry Enter registry patch file, which is to be used to 
apply updates to the registry database. 

OK Button To apply updates. 
Cancel Button Abort process. 
“Select Patch File” Button Use to locate registry patch file. 
Help Button Displays extra information related to application of 

patch files. 
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4.1.5.2.1.7 ECSAssist Subsystem Manager’s “Stage Install” Screen 
The stage install screen is used to input the staging location where the delivered software is 
stored. From the ECSAssist Subsystem Manager screen, click the stageinstall button to initiate 
the viewlog process. 

Figure 4.1.5-10 below presents the stage install screen. 

 

Figure 4.1.5-10.  Subsystem Manager “stageinstall” Screen 

Table 4.1.5-11 describes the control and information fields on the stageinstall window. 

Table 4.1.5-11.  ECSAssist Subsystem Manager stageinstall Field Descriptions 
Option/Field Action Description 

Provide staging area source location Display Only Label for input field immediately below. 
Input field Input Type in the staging area filename. 
Ok Click Accepts the user’s entry. 
Cancel Click Aborts the process. 

 

4.1.5.2.2 ECSAssist ESDT Manager 
The ESDT Manager facilitates the configuration of ESDTs into a mode.   

Figure 4.1.5-11 shows the main window of the ESDT Manager. 
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Figure 4.1.5-11.  ESDT Manager Main Window 

Table 4.1.5-12 describes information and control fields on this window. 
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Table 4.1.5-12.  ESDT Manager Window Field Descriptions 
Option/Field Action Description 

File -- -- 
Exit In the file menu, click Exit. Exits ESDT Manager. 

Latest Info Click on Latest Info button Pull down menu showing a list of subsystem specific 
executables used for supporting tasks. 

Radio Buttons -- -- 
EDF Click radio button  To set ESDT destination location for EDF sites. 

MINI-DAAC, 
VATC and all 

DAACs 

Click radio button To set ESDT destination location for NON-EDF sites. 

MODE list box Allows the operator to designate which mode to 
configure ESDTs. 

DLL PATH entry  Allows the operator to designate the source location 
for Dynamically Linked Libraries (DLLs). 

Staging 
Location 

entry  Used to determine location of ESDTs and DLLs at 
DAACS. 

Configure Click button Initiates configuration of ESDTs. 
Verify Click button Verifies the selected ESDT. 
Instrument List  [buttons] As (Aster), Ce 

(Ceres), Ea (External 
Ancillary), Ed (EDOS), Ls 
(Landsat), Mi (Miser), Mo 
(MODIS), Mp (MOPPIT), Sa 
(Sage III) and Sys (System 
related instruments) 

Each button generates a list of instrument specific 
ESDTs into the “Descriptor Files” list box.  The 
Operator can then select one or all into the “Selected 
Files” list box. 

Descriptor 
Files 

List Box (Gives number of 
instruments in list.) 

Contains a list of instrument specific ESDTs. 

View File Click button Displays the contents of the selected ESDT. 
Selected Files List Box (Gives number of 

instruments in list.) 
Contains a list of selected instrument specific ESDTs. 

Remove Click button Remove selected ESDT from the “Selected Files” list 
box. 

Clear All Click button Removes all ESDTs from the “Selected Files” list box. 
Results text box Displays results of the configuration process. 
Current 
Directory 

status bar (display only) Displays the directory of the currently selected 
instrument. 

Directory 
Statistics 

status bar (display only) Displays directory statistics of the currently selected 
instrument. 

GUI 
Information 

None -- Display only bar 

4.1.5.2.3 ECSAssist System Installer (E.A.S.I.) 
E.A.S.I facilitates a complete or partial installation of ECS software, creation of configuration 
files, and execution of database operations by a single user who is familiar with the proper 
installation instructions. 
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Figure 4.1.5-12 shows the E.A.S.I. Installation Source window, which comes up as a result of 
hitting the “E.A.S.I.” button on the ECSAssist main window.   

 

Figure 4.1.5-12.  E.A.S.I. Installation Source Window 

Table 4.1.5-13 describes information and control fields on this window. 
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Table 4.1.5-13.  ECSAssist E.A.S.I. Installation Source Field Descriptions 
Option/Field Action Description 

Mode (combo box) Click To view a list of available modes.  User can select 
only one mode. 

Enter staging area source 
location below  

Display Only Staging area source location field identifier. 

Staging area source location 
entry  

Enter if 
available 

Staging area source location entry becomes 
available when a ClearCase view is not available.  
Enter the staging area source location without the 
architecture and with the word “TOOLKIT” 
(e.g., /net/tacoma/dist/DROP50). 

Type of installation  Display Only Identifies the installation options. 
Full Click  Facilitates a complete installation of ECS custom 

software. 
Custom Click Allows the user to facilitate a customized installation

(e.g., The user may only want to install on three 
hosts or may only want to install Subsystem DSS on 
all hosts). 

Cancel Click Returns the user to ECSAssist main menu. 
Next Click When enabled, allows the user to proceed to the 

next window. 

Figure 4.1.5-13 is the E.A.S.I. Phase Selections window.  The user can select any phase to 
execute.  Associated phase windows are displayed depending on what phases are selected. 

 

Figure 4.1.5-13.  E.A.S.I. Phase Selection Window 

Table 4.1.5-14 describes the control and information fields on the E.A.S.I. Phase Selection 
window. 
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Table 4.1.5-14.  ECSAssist E.A.S.I Phase Selection Window Field Descriptions 
Option/Field Action Description 

Execution Phases  Display Only Identifies the option buttons for selecting the phase of 
installation. 

Install Click on/off Selects installation of ECS custom software. 
Config Click on/off Selects the creation CFG and PCFG files. 
Dbase(s) Click on/off Selects the execution of selected database operations. 
Cancel Click Returns the user to the ECSAssist main menu. 
Back Click Returns the user to the previously selected window. 
Next Click Allows the user to proceed to the next window. 

Figure 4.1.5-14 is the E.A.S.I. Installation Parameters window.  It allows the user to select 
Installation criteria.  If a ClearCase task is not set or not available, the Installation Type defaults 
to the Staging Area option. 

 

Figure 4.1.5-14.  E.A.S.I. Installation Parameters Window 

Table 4.1.5-15 describes the control and information fields in the E.A.S.I. Installation Parameters 
window. 
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Table 4.1.5-15.  ECSAssist E.A.S.I Installation Parameters Window  
Field Descriptions 

Option/Field Action Description 
Installation Type Display Only Identifies the three installation type options. 

Development Click  Creates symbolic links to ClearCase. 
Normal Click  Copies binaries and libraries to the selected mode. 

Staging Area Click Installs the mode from the staging location. 
Source File Location  Display Only Identifies the two options for selecting source files. 

Stage Click  To obtain files from the nightly build. 
Non Stage Click  Allows testing of changes before merging to a 

branch. 
Cancel Click Returns the user to the ECSAssist main menu. 
Back Click Returns the user to the previously selected window. 
Next Click Allows the user to proceed to the next window. 

Figure 4.1.5-15 is the E.A.S.I. Database Operations window.  Select an operation other than 
“Clear” and the subsystem specific script parameters are displayed.  Enter the correct 
information for the selected subsystem.  Notice there is a tab for only subsystems that require 
database operations. Note: The Interoperability Subsystem (IOS) has been removed from the 
baseline system for this version of Release 6B. 

 
Figure 4.1.5-15.  E.A.S.I. Database Operations Window 
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Table 4.1.5-16 describes the E.A.S.I. Database Operations window control and information 
fields. 

Table 4.1.5-16.  ECSAssist E.A.S.I Database Operations Window  
Field Descriptions 

Option/Field Action Description 
Operations Display Only Identifies the button selectable for Dbase options. 
DbBuild Click Facilitates execution of the database build operation. 
DbDrop Click Facilitates execution of the database drop operation. 
DbDump Click Facilitates execution of a database drop operation. 
Dbpatch Click Facilitates execution of a database patch operation. 
DbLoad Click Facilitates execution of a database load operation. 
DbValids Click DSS Science Data Server only. Facilitates execution 

of a Valids script for use with ESDTs. 
Subsystems 
specific script 
parameters  

Display Only  Heading.  By selecting a tab, the heading changes 
according to the selection. 

Mode Display Only Displays the selected mode. 
Dbo Id Entry Enter Dbo Id. 
Password Entry  Enter password. 
SQL Server 
Name 

Entry  Enter SQL server name. 

Database Name Entry Enter database name. 
Cancel Click Returns the user to the ECSAssist main menu. 
Back Click Returns the user to the previously selected window. 
Next Click Allows the user to proceed to the next window. 

Figure 4.1.5-16 is the E.A.S.I Installation Confirmation window.  If there is an incorrectly 
selected item, click the “Back” button until you have reached the window requiring the change 
and make the change.  When the change is made, click the “Next” button until you have reached 
the “Installation Confirmation” window. 
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Figure 4.1.5-16.  E.A.S.I Installation Confirmation Window 

Table 4.1.5-17 describes the control and information fields in the E.A.S.I. Installation 
Confirmation window. 

Table 4.1.5-17.  ECSAssist E.A.S.I. Installation Confirmation Window  
Field Descriptions  

Option/Field Action Description 
Please review information 
below 

Display Only Requests the user to review the information 
immediately below in a scrollable text box. 

Information in Text Box Read Only Contains a log of the installation. 
Cancel Click Returns the user to the ECSAssist main menu. 
Back Click Returns the user to the previously selected window. 
Next Click Allows the user to proceed to the next window. 
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Figure 4.1.5-17 is the E.A.S.I STATUS window. 

 
Figure 4.1.5-17.  E.A.S.I. STATUS Window 
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Table 4.1.5-18 describes the control and information fields in the E.A.S.I. STATUS window. 

Table 4.1.5-18.  ECSAssist E.A.S.I. STATUS Window Field Descriptions 
Option/Field Action Description 

Utilities Menu -- 
Close all open sockets Click Closes all the opened connections.  Waits for 4 

minutes and resets communication and selected 
phases to “waiting.”  This allows users to re-run 
selected phases. 

Max Requests Click Controls the number of server calls over the network. 
COMM (Button) Click Initiates the communication phase.  Starts the servers 

on selected hosts. 
INSTALL (Button) Click Initiates installation of the ECS custom software. 
CONFIG (Button) Click Initiates the creation of CFG and PCFG files. 
Cancel Click Returns user to the ECSAssist main menu.  All 

connections to the server are terminated. 
Back Click Returns the user to the previously selected window. 

4.1.5.3 Required Operating Environment 
For information on the operating environment, tunable parameters and environment variables of 
ECSAssist refer to the 920-TDA-022 “Custom Code Configuration Parameters” documentation 
series. 

4.1.5.3.1 Interfaces and Data Types 
None. 

4.1.5.4 Databases 
No database is associated with or used by the ECSAssist.  ECSAssist can create configuration 
files for software components, remove outdated log files, or update other files related to the 
functions performed. 

4.1.5.5 Special Constraints 
None. 

4.1.5.6 Outputs 
Output from the ECSAssist tool consists of the data displayed on the GUIs described in 
Section 4.1.5.2.1 and error and event messages described in section 4.1.5.7 

4.1.5.7 Event and Error Messages 
Event and Error Messages for ECSAssist are listed in Appendix A.  All outputs associated with 
the ECSAssist are captured in a file called “/tmp/<userid>.ecs_session.log”. 
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4.1.5.8 Reports 
None. 




